The Digital City: Warmoesstraat in 16™ Century

Manual: Weixuan Li, summer 2017

PART I: A data view of Warmoesstraat and its surroundings

You probably have wandered in the restaurant/shop-packed Warmoesstraat in the heart of Amsterdam. Now
you have a chance to create a virtual time machine taking people back to the 16™ century by visualizing the
same street using the data available from historical records.

The historical information about Warmoesstraat and its surroundings is summarized in an Excel spreadsheet
including the following columns:
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= ID An unique number that indicates the number of the record in the entire

document

= Fol. Page number of the original document

= Persoonsnaam Person’s name

= Beroep Profession

=  M/V bewoner Male/Female inhabitant/tenant

= Straat Street

= KadSectieNr Section in 19th century map

= Nr. House number

=  Bouwblok Building block, we can add this, based on the block map

= Aanduiding/ huisnaam House name

= Opmerkingen h. van means: tenant, house is owned by XX

= M/V eigenaar Male/Female house owner

= Huurwaarde Rent value of the house (per year)

The following assignments will guide you to present this information on a map of Amsterdam using QGIS.



PART II: Install QGIS and introduction

1. Installation:

For Windows users:

Download and run the standalone installer, available here:

http://qqgis.org/en/site/forusers/download.html (QGIS Standalone Installer Version 2.12)

When it gives you the option, you do not need to download the sample datasets, although feel free to do so
and use them for other tutorials or examples.

Double click your installation package and follow the steps.
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Video guide: https://www.youtube.com/watch?v=Io0NPpcOb-sE

For Mac OS users:

0S 10.7 and Higher: Follow the installation instructions provided here:
http://www.kyngchaos.com/software/qgis

0S 10.6.8: Try using the latest experimental builds for Mac OS 10.6.8 provided here:
http://qgis.dakotacarto.com/ (scroll down to and click on “Nightly for Snow Leopard - Mac OS X 10.6”).
Alternatively, try compiling with HomeBrew (http://brew.sh/), following instructions here:
https://github.com/OSGeo/homebrew-osgeo4mac

Notes for Mac OS users:

Unlike Windows, QGIS has 4 packages for Mac OS to install. They are numbered in the package you have
just downloaded, so please install following the sequence.

Video guide: https://www.youtube.com/watch?v=MnXi5b2pgDo

LET OP: Since QGIS is a third-party software (i.e., not from the Apple store), you may need an extra step to
authorize the installation. When you double click on the first package, you will see this window:

“1 GDAL Complete.pkg” can’t be opened

& J because it is from an unidentified developer.
Your security preferences allow installation of only
apps from the App Store and identified developers.

“1 GDAL Complete.pkg” is on the disk image
“"QGIS-2.18.2-1.dmg". Safari downloaded this disk
image on April 7, 2017.

? —



http://qgis.org/en/site/forusers/download.html
https://www.youtube.com/watch?v=IoNPpcOb-sE
http://www.kyngchaos.com/software/qgis
http://qgis.dakotacarto.com/
https://github.com/OSGeo/homebrew-osgeo4mac
https://www.youtube.com/watch?v=MnXi5b2pqDo

Click [OK], and this window will pop up, then click [Open the General panel for me], and in the following
window, click [Open anyway]:
[ig] & Mac Help

il Q

@ Open an app from an unidentified developer

If you try to open an app that is not registered with Apple by an identified developer you get a warning dialog.
This doesn’t necessarily mean that something’s wrong with the app. For example, some apps were written
before developer ID registration began. However, the app has not been reviewed, and macOS can't check
whether the app has been modified or broken since it was released.

A common way to distribute malware is to take an innocent app and insert harmful code into it, and then
redistribute the infected app.

The safest approach is to look for a later version of the app from the Mac App Store or look for an alternative
app.

To override your security settings and open the app anyway:

1. In the Finder, locate the app you want to open.
Don't use Launchpad to do this. Launchpad doesn’t allow you to access the shortcut menu.
2. Control-click the app icon, then choose Open from the shortcut menu.

3. Click Open.

The app is saved as an exception to your security settings, and you can open it in the future by double-
clicking it just as you can any registered app.

Note: You can also grant an exception for a blocked app by clicking the “Open Anyway"” button in the General
pane of Security & Privacy preferences. This button is available for about an hour after you try to open the
app.

To open this pane, choose Apple menu > System Preferences, click Security & Privacy, then click General. |

Open the General pane for me

To change your security settings, szaiware.

[ ] < ifii Security & Privacy Q

Filevault  Firewall  Privacy

A login password has been set for this user | Change Password...

Require password immediately [ after sleep or screen saver begins

Show a message when the screen is locked

Allow apps downloaded from:

*1 GDAL Complete.pkg” was blocked from opening because it is not
from an identified developer.

[ Click the lock to make changes. ?

After you have clicked [Open anyway], the new window will have a [Open] button. Click it and do the same
for all four packages. Then follow the instructions to install.



After successfully installing QGIS, you can open it by clicking:

"4 Install QGIS.pkg" is from an unidentified
developer. Are you sure you want to open it?

Opening “4 Install QGIS.pkg” will always allow it to run
on this Mac.

“4 Install QGIS.pkg"” is on the disk image
“QGIS-2.18.2-1.dmg". Safari downloaded this disk
image on April 7, 2017.
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2. The basics of the QGIS user interface:
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The elements identified in the figure above are:

agrwdE

Toolbars

Side Toolbar
Layers List / Browser Panel
Map canvas

Status bar

You will use the sections for the next tasks.

In the following sections, Text that [Looks like this] directs you through menus and buttons.



PART Ill: Creating your own maps in QGIS

Task 1

: Create a new map and set coordinate system
Open QGIS and create a blank project (default)
Set coordinate system:
o Click top menu: [Project] - [Project Properties...]

ece New N | QGIS 2.18.2
Onen=: 0p o @m ¥ 0 G o [0SR e, D &, 0 = — T|
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A [ Open Recent > [ e 3 e "V = = E w5 Jesw "I}
00 Hsae #S |
— oy [@Savess.. %S
Lo d

2
» |
)

" OWS

1 =4 Save as Image...
| DXF Export...
DWG/DXF Import... g¢

| Project Properties... {*3P

| - New Print Compaser ®P
| «, Composer Manager...
, Print Composers >

0 Inthe pop up window:
= Click [CRS] on the side menu
= Check [Enable ‘on the fly’ CRS transformation (OTF)] box
= Type in Amersfoort in the [Filter]
= Select Amersfoort RD/new; EPSG:28992 from the list below
»= Click [OK]

[ BaN ] / Project Properties | CRS
Enable 'on the fly' CRS transformation (OTF)
_:é CRS Filter amer
- Recenlly used coordinale [elerence systems
N |denti Coordinate Reference System Authority ID
Amerstoort EPSG:4288
De Amersfoort / RD New EPSG:28092
1 O
Lal ourcoe
h Coordinate reference systgms of the world Hide deprecated CRSs
Coordinate Reference System Authority ID
South_Americ§_Equidistant_Conic EPSG:102032
v Lambert Conformyl Conic
American Sampa 1962 / American Samoa Lambert EPSG:3102
American Sampa 1962 | American Samoa Lambert (dep... EPSG:2155
American Samrpa 1962 / American Samoa Lambert (dep... EPSG:2194
North_Americqd_Lambert_Conformal_Conic EPSG:102008

South_Amerigg,Lambert_Conformal_Conic EPSG:102015

EPSG:2/002
Amersfoort /| RD New EPSG:7415
Amersfoort / AD Old EPSG:28991

Selected CRS: Amersfoort / RD New

+proj=sterea +lat_0=52.15616055555555 +lon_0=5.38763888BB8889 +k=0.9099079 +x_0=155000
+y_l;}“:463000 +;I?)s=bessel +lowgs84=565.417,50.3319,465.552,-0.308957,0.343088,-1.8774,4.0725
+Uunils=m +no_dels

v
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Task 2: Load the shape files
= Goto[Layer] > [Add Layer] > VS [Add Vector Layer]

. — s X __
& QGIS Project Edit Vi Settings Plugins Vector Raster Database Web Processing Wirllow Help  w)) 100% B4 E= Sung843AM Q @ =
ene Create Layer » QGIS 2.18.2
. == N [ Add Layer » Add Vector Layer... R 1 o
1 [ . £ [ | T
‘- H &é Y Embed Layers and Groups... . Add Raster Layer... OHER E 3 @ - 2 L loh O E n
Add from Layer Definition File... W, Add PostGIS Layers. o%p P
- v = = >
add s oo
Browser P
v (] i B Add MSSQL Spatial Layer.. %M
2 D eY®*o B3, Add DB2 Spatial Layer... ox2
B v o data package € Add WMS/WMTS Layer... TEW
o AFS_unit_2017_UTM33 @ Add WCS Layer...
£ = :‘:““u"m;m“”‘”‘ 4% Add WFS Layer..
- m_ .| "
@ I cem_UTMaIN t.ovr 2, Add Delimited Text Layer..
Qv finddata xls Wi Add/Edit Virtual Layer...
I ¥ gearth_2017_UTM33Nj
b ’ gearth_2017_UTM33N.| 4 Remove Layer/Group ®D
B oearth_2017_UTMAAN;
R gearth_2017_UTM33N,
= geol2017_UTM33N.sh
‘-% research_area.shp
= sampleareas_2017_UTl
95 | v = Digitale tools Stadsgeschier
AMS_Cholerkaart.shp
?‘ﬁ I AmsterdamWikindeling'
B AmsterdamWijkindeling' =
Vo AmsterdamWikindeling’
AmsterdamWilkindeling: 75 Add All to Overview
AMSWijkindeling1850.s1  ©Z Remove All from Overview
B Chnlarskaart Risnndars
# Show All Layers oRU
ee Gt Hide All Layers 0%H
N y @ 2 = Show Selected Layers
= B Hide Selected Layers
Coordinate  118524,489590 | § | Scale 1:20,784 B & | Magnifier 100% | Rotaion 00 - [ Render £ USER:100000 | &

= In the pop up window, click [Browse] and select shapefile AMS_Blokkenkaart.shp from the list.

This shape file shows the building blocks of Amsterdam around 1550s.
= Click [Open] and it loads into your QGIS project
(You only need to load the .shp file, since the other files in the shapefile folder provide supporting

information for .shp file.)

Source type

File Directory Database Protocol
Encoding | System

Source

Datasel Browse

Halg Cancel Open
Congratulations! You now have a basic map. Repeat the previous steps to load the other
layer Warmoesstraat_percelen1550.shp (with parcels of land along Warmoesstraat).
The two layers will serve as a basis for your future mapping.

= Now would be a good time to save your work.

-
= Click on the [Save as] button: “=£3
= Save the project under the folder of your choice. Your project will be saved in .qgs format.

Once the shapefile is loaded, you can see the blocks and parcels of Amsterdam in simple, (random) single-

color polygons. Now you can zoom around it using the map navigation tools (in the red bar area).

—
(]

[Tip] Apart from using the @ m and 42 = | S5 = joons on the toolbar with the mouse, navigating can

also be done with the mouse wheel, spacebar and the arrow keys.
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[Tip] in case you ‘lost’ the map (by zooming out too much or move it out of your sight), you can always click

cﬂ [zoom full] to bring the shape file to your screen.

Let’s take a look at the data behind the polygons:

= QOpen the attribute table of Warmoesstraat_percelen1550: Right click the layer > [Open Attribute
table]
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Take a close look at the attribute table. If you feel more comfortable playing with data in Excel, the Excel
spreadsheet of the same dataset can also be found in the package.
In the following assignments, you will use the information in the attribute table to create your own map
showing the desired information.

Task 3: Add a new layer/ Copy a layer to show rental values
At this stage we have a base map showing the building blocks in Amsterdam and the parcels along
Warmoesstraat. We will need another layer to show the spatial distribution of rental values along
Warmoesstraat. Instead of creating another map file from scratch, we can simply duplicate the
Warmoesstraat_percelen1550 layer and change the display to a different attribute, in this case, the rental

value.

» Right click on Warmoesstraat_percelen1550, then click on [Duplicate]
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Task 4: Color-coding Warmoesstraat parcels based on Huurwaarde

In the [Layers Panel] on the left, click on the box before the copied layer to make it visible and drag
it to the top of the list. Please note that the display of layers in QGIS follows the sequence showing on
the [Layers Panel]. For layers with overlapping area, you need to place the layer you want to show on

top, or make the layers above invisible by unchecking them.

Then, right click on the layer name, select [Rename] and change the layer name to ‘Huurwaarde.’

Q00
& - T

[l warmoesstraat percelen1550
[l Warmoesstraat_percelen1550 copy

B AMS_Blokkenkaart

Layers Panel
Lo P S [

006
& e T

Layers Panel

S B B

i Huurwaarde
[l Warmoesstraat_percelen1550
[ |

AMS_Blokkenkaart

>

Double click the layer’s name: Huurwaarde (or right click on layer’s name, then click on

[Properties])

Click on the [Style] side menu



No symbols a

No symbols
= Single symbol
= Categorized
No symbols will be rendered for features in this layer.
= Rule-based
O Inverted polygons
= 25D

w Layer rendering
Layer transparency

Layer blending mode Normal &
Fealure blending mode Normal B

Draw effects

Control feature rendering order

Help Style v Apply Cancel | (NOKEN

= Select [Graduated] from [No symbols] drop-down menu

= In the [Column] drop-down menu, select [Huurwaarde]. This option defines which attribute will be
presented on the map. *

= Then in the [Mode] menu, select [Quantile (Equal Count)]

= Change the [Classes] number from the default 5 to 8, then click [Classify]

® @ ' Layer Properties - Huurwaarde | Style

Legend Format %1 - %2 Precision 4 o Trim
Method Color &
o Color ramp -Btuas E Edit Invert
Hiatogam
Mode | Equal Interval Classes 5 - Classity

Symbol v Values  Legend

Add class Delata Delete all ) Link class boundaries
i
w Layer rendering
Help Style « Apply Cancel *
Hetogram
Mode  Equal Interval a Classes @ | | Classity |
o | atur; Baks (Jeni |
Sym  Standand Deviation and
Preity Braaks

= Click [Values] column to have the value show in a descendent order

! The rental value is mentioned in the kohier of 1562. People who rented a house had to show the tax officials the lease
agreement, which also mentioned the sum they should pay for rent. The tax officials estimated the value of the houses,
which were occupied by their owners. How they exactly came to this estimation, is still a theme for further research.
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/! Layer Properties - Huurwaarde | Style

¢
Column 123 Huurwaarde n £
Symbol [l Change...
B8 Flelds Legend Format %1 - %2 Precision 0 s | Tim
& Rendering Method Color
- Display Color ramp I source] a Edit Invert
8 Aotons Histograrm
§ Joins Mode Quantile (Equal Count) Classes (8 ||| | Classify
|8 Diagrams
Symbol v alues Legend
fi Metadata | i 40-73
[] 7300-10000 73-100
Variables [] 100.00-120.00 100-120
Add class Delete Delete all Link class boundaries
Advanced v
w Layer rendering
Help Style v Apply cancel | (NCKIN
= Click the [Color ramp] menu, and select [New color ramp]
Colorramp = New rnlar ramn Edit | Invert

- @ @ 4 Color ramp type

am
Please select color ramp type: L_

: +/ Gradient
Mode | Quantile (Equal Count Random B isify

_
Symbol  Values y  optaiy |

| 225.00 - 370.00
, Ql  20000-22500 2002225

v B 180.00 - 200.00 180 - 200

= In the pop-up window, select [ColorBrewer] — [Scheme name] to Spectral and [Colors] to 8 and
click [OK] (you can save the scheme with the name of your choice)
® @ & ColorBrewer ramp

Scheme name B |l Spectral B
Colors (5 %]

Preview
. S

Cancel
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= Click [OK]. You will now see the parcels are shown in different colors based on huurwaarde. Your
map may look like this:

A -
Project home

>

> Home
> Favourites
>

>

/

Nolumes
B MSsaL
@ FostGIS
# SpatiaLite

06 Lanynes Paned
£ % T Gyd A 01

225 - 370
B 200-225
7] 180- 200
| 150- 180
| 120-150

[T 100-120

B 73-100

W -7
Warmoesstraat_perceleni 550
AMS_Biokkenkaart

-

NSBPSHBINSRS &L

Jf - R<J<J=
..El........

as

Toggles the editing state ol the current layer

Question: What can you learn from this map?

PART VI: Exporta Map

Before you export a map or start working with the Print Composer, you need to load the QGIS map canvas
and adapt its properties to suit your own convenience (i.e., zooming in to the parts you want to show). After

everything is rendered and symbolized to your liking, click the@NeW Print Composer jeon in the toolbar or
choose [Project] > [New Print Composer]. You will be prompted to choose a title for the new Composer.

’
% Composer title M

Create unique print composer title
(title generated if left empty)

Task 1: Add a Mapping Area

Click on the [ &5 A% rewma 4o 01har button in the Print Composer toolbar to add the QGIS map canvas. Now,
drag a rectangle onto the Composer canvas with the left mouse button to add the map.
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https://docs.qgis.org/2.14/en/_images/mActionNewComposer.png
https://docs.qgis.org/2.14/en/_images/mActionAddMap.png
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Task 2: Edit a Mapping Area
You can resize the map item by clicking on the i SelectMove item py selecting the element, and dragging one

of the blue handles in the corner of the map. This button also helps to move the map to another place. Select

the item and while holding the left mouse button, move to the new place and release the mouse button.

To move layers within the map element, select the map element, click the

layers within the map item frame with the left mouse button.

To zoom in and out for the content area of the map, click the
zoom in and out within the content area. Or click [Set to map canvas extent] on the [Item properties] tab.

x:312.8 mm

in g ®

[E Move item content

y:15.6624 mm  page: 1

[E Move item content

Huurwaarde1550
MNBPLPLPRE LRAALCEH B &
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Wep 0 : e
Draw map canvas items
Lok layers for map itam % €
Lock layer stylas for map item S,
w Extents
Xmin 121250.881 LS
Y min 487265.531 E'
X max 121959.141 S,
¥ max 487758.266 =L

Sel lo map canvas extent

View extent in map canvas

b Controlled by atlas
p Grids

icon and move the

icon, and scroll up and down to
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https://docs.qgis.org/2.14/en/_images/mActionSelect.png
https://docs.qgis.org/2.14/en/_images/mActionMoveItemContent.png
https://docs.qgis.org/2.14/en/_images/mActionMoveItemContent.png

[Tip] After you have found the right place for an item, you can lock the item position within the Print
Composer canvas. Select the map item and use the toolbar B Lock selected Htems (on the top of this Map Composer
window). A locked item can only be selected using the [Item properties] tab. Once selected, you can use

the [Items] tab to unlock individual items. The ©UMeck Al ems joon \will unlock all locked composer items.
With the map selected, you can now adapt more properties in the map [Item properties] tab.

Task 3: Add a Legend

To add a map legend, click the & Addnewlesend joon place the element with the left mouse button on the Print
Composer canvas and drag to position. To customize the appearance in the legend use the [Item
properties] tab on the right side of the window.

Because we are only showing the rental values in this map, we can uncheck the [Auto Update] box, and use

the [minus] button to remove the other layers you do not want to list in the legend. This change only applies

to the legend of the output. If you want to change the visibility of your layer, you have to go back to the main
map.
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W o [ 8 = M P ? e it T P R S,
PV TP OO TN WO PO TR OO T o O TP TN 0O . Y3 tems
oy Change ilem positon
e £ e e i
s nge fem position
|'—." a: Change item position
_M E Maove item content
= Legend added
15 iﬂé Change itam puslbun
= E

I
| I Wamoesstraat perceisn iS5

| AMS Biody it

v|a a|#]=]2 =75

% 259101 mm  y: 158414 mm page: 1 T8.8% niiwmumed

Task 4: Add a Title
It is like adding a text box in a PowerPoint.

i i . i
* Click on addtext in the sidebar

= Type in: Title of your map, your name and the date into the box on the right
* You can also change the font size by clicking on the [Font...] button on the right
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= Select the type for export:
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Spatial Distribution of Housing Value along
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The @ Pt icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.

The Bxportasimage joon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

The EH Exportas SVG joon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).
The % Exportas POF joon saves the defined Print Composer canvas directly as a PDF.

= .
(NOTE: the save Project joon can only save the features of your design in QGIS, but cannot be used to export a map.)

= Enter the name of your map. You can also select your desired file type (.jpg, .png, etc.)
= Click [Save], then in the pop up window you can change other options, the default is usually
preferred. Then click on [Save] to finish export.

[ NeN ] /' Image export options
Export options

Export resolution ' B00 dpi
Page width 3507 px

Page height 2480 px

v Crop to content
Top margin 0 px
Left 0px Right 0px

Bottom 0px

cuce (N

Your final map may look like the following:

Spatial Distribution of Housing Value along Warmoesstraat
Jane Doe, 7-9-2017

o ® V%
7 45

Bl AMS_Blokkenkaart
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Task 6: Your Own Question and Solution

With all the tools you have learned (color-code the housing value based on the information you want to
present) what question(s) are you interested in? Can you use the tools to answer your own question? Think
freely about the data you would need and the way in which to answer the question.

PART V: To own, or to rent, that is the question (Week 2)

With the house ownership information available, we are curious which houses were owned by the resident and
which were rented. We would need your help to create a map showing the spatial distribution of ownership.

Based on the value from the attribute table, we have 4 types: eig/huur, and eig?/huur?, when we are not sure.
To visualize them on the map, we need to mark the parcel differently.

Make a copy of Warmoesstraat_percelen1550 layer (Hint: right click the layer -> [Duplicate])
Change the layer name into Eighuur (Hint: right click the layer -> [Rename])
Move Eighuur layer to the top of the layers menu
Go to [Properties]
0 Inthe top drop down menu, selected [Rule-based]

o Click the green plus button @ (o add a filter

el

2 Single Symbol | # Layer Properties - Beroep | Style

= Categorized a

= Graduated

= Rule-based Ll Min. scale  Max. scale Count Duplicate count

§ Point Displacement
O Inverted Polygons
+ Heatmap

25D

£ Refine selected rules - Count features Symbol levels...

w Layer rendering
Layer transparency 1 o
Layer blending mode Normal E Feature blending mode Normal &

Draw effects

Control feature rendering order

LD EII B Canc

5. In the pop-up window, we can create our own filter. We want to select the parcels of which the value
in ‘Opmerking’ column includes h. van XXX
0 In[Lable]: type in Rent
o In [Filter]: type in "Huurwaarde™ > 0 AND "Opmerking" Like '%h.%', meaning “select the
parcels of which the value in column Huurwaarde is greater than 0 (meaning we have the
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information in the other columns) and column Opmerking includes ‘h.” (or click =« for

more options).

o [LIKE] is an operator that returns 1 if the string matches the supplied pattern.

[ ] A Layer Properties - Eighuur | Style
I Label Rent
| Filtar _i'Huurwaarﬂa" =0and "Opmearking" ke 9:h.5%"
)
I Description
Scale range
Minimum Madmum
{axclusive) 4= |1:100,000 (nclusive) + 1:1,000
Symbel
Unit Millimeter a
. ha b
Color 1
DRI
W Simple fill i q
e sagona doted graen tand watnr
*

0 (YYou can change the color composition in the [Color] menu)

0 Once you finish editing, click [OK]

Then repeat the same steps to create a filter for owner:

0 In[Lable]: type in Own
0 In[Filter]: type in "Huurwaarde" > 0 AND "Opmerking" IS NULL

‘Label

& Stk

& )
w Layer rendering

"Huurwaarde" > 0 and "Opmerking" like %oh.%"
"Huurwaarde" > 0 and "Opmerking" is Null

Refine selected rules Count features

Layer transparency

Layer blending mode Normal Feature blending mode
Draw effects
Control feature rendering order

Help Style = Apply

0 Once you finish editing, click [OK]

ﬂ Open Library

Advanced »

Cancal

~Min.scale  Max.scale Count Duplicate count

Cancel OK
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Then you will see your map colored based in the ownership, like the following example:
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< I Own
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L [l Warmoessiraat_perceleni550
Ve Il AmS_Biokkenkaart
ol
Toggles the aditing state of the current layer Coordinate 121714.9,487457.5 9% Scale 12136 ﬂ Rolation (0.0 > [ Render| §) EPSG:28002 (OTF) @

4

6. Export your map as Eigendomkaart [Review Part IV for instructions]

Question: Comparing the Huurwaardekaart (from Task 3) and the Eigendomkaart you have just generated,
is there a relationship between the estimated house value and the ownership situation?

PART VI: You are what you do: Occupation (Week 2)

From the attribute table, we also know the occupation of the resident of each house. Can we visualize
the spatial distribution of occupation on the map? Of course, we can filter the whole street by certain
occupation. Let’s use merchants (koopman) as an example:

1. Make a copy of Warmoesstraat_percelen1550 layer (Hint: right click the layer -> [Duplicate])
2. Change the layer name into Beroep (Hint: right click the layer -> [Rename])
3. Turn off all the layers we generated earlier by unclick box before the layer’s name

26 Layers Panel
@ % T &y & @ [

> ) Eighuur
> - Huurwaarde
. Warmoesstraat_percelen1550

-4 [ Ams_Biokkenkaart

4. Right click Beroep layer -> [Properties]
0 In the top drop down menu, selected [Rule-based]
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0 Click the green plus button & to add a filter

2 Single Symbol ! # Layer Properties - Beroep | Style
= Categorized a

L/ Style Min. scale  Max. scale Count Duplicate count
&Y

+) Point Displacement
I Inverted Polygons
+ Heatmap
& 25D

& Refine selected rules » Count features Symbol levels...
w Layer rendering
Variables Layer transparency —~ o -
Layer blending mode Mormal |5 Feature blending mode Normal 2]
Draw effects

Control feature rendering order

Help Style v Apply Cancel —

5. In the pop-up window, we can create our own filter. We want to select the parcels that the value in
‘beroep’ column includes koopman
0 In[Lable]: type in koopman
o In [Filter]: type in "beroepCal5" LIKE '%koopman%'’, meaning “select the parcels of which

the value in column beroep looks like koopman (or click | for more options).
* [LIKE] is an operator that returns 1 if the string matches the supplied pattern

L - ® . ! Layer Proparties - Beroep | Style
i Label | koopmar{
! ] Filter "bgroapCai5” LIKE Ykoopman®' -
|
on
| Scale range
Minimum Umbnaim
(exclusive) » 1:100,000 finclusive) 1:1,000
Symbel
Unit Miimatar E
Transparency 0% « -
Color
-
-mm [ B orentiy
] Simple fit t 1 - - =
ol oyl e = Lo
# Save Advanced

conel | (KD
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0 (YYou can change the color composition in the [Color] menu)

0 Once you finish editing, click [OK]

In the steps above, we only create one filter to show the houses of the merchants, therefore only the parcels
that the residents’ occupation registered as koopman are marked in the map.

DEBBORNLALALAAPP AR &

v OB sz W ey =y m A

Beowser Panel
T T O

Project home
Home
Favourites
!
Nolumes
» MssaL
@ PostGIS
# SpatiaLite
06 Layors Panol

& » T ty@ 2 O
[77] koopman
» Elghuur
» Huurwaarde
Bl Warmoesstraat_percelen1550
B AMS_Biokkenkaart

Q

vrvrrllolol
o

-

NSBXPOSHIFINNSRS &

Toggles the editing state of tha current layer jon |0, * 3 Render| ) EPSG28002 (OTF) &

Questions:
1) Can you create another filter for a profession (or set of professions) of your choice?
2) What can you learn from the spatial distribution of the houses of koopman?
3) Do you think “koopman” is a good category for professions? Please explain your answer.
4) How would you like to group the professions of residents? Can you come up with a guideline to group
the professions into categories?
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